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Introduction

This document guides users and administrators through the user interface changes and new features in DocMoto version
4.

Updates:
User interface:

1. Tree-view and main integrated to one main view.
2. Tree-view replaced with side panel with collapsible section headers such as:

a. DocMoto — the three main areas:

i. Contents — main shared area
ii. Trash — user’s trash bin
iii. Home - private area for user

b. Favourites — removed from toolbar and added to side panel to enable drag and drop, similar to the Finder
application.

¢. Recent Documents — lists documents most recently interacted with.

3. Tabbed user interface — create tabs for:

a. Different areas of DocMoto.

b. Searches

c. Views

d. Copying data from one area to another

4. Document control center — the details pane has been modified to show meta-data (system & business defined)
with a useful integrated preview and document walker control.

a. Document walker control — when the control center is open the user has a limited view of the tree
structures available; the document walker moves efficiently through a folders contents and potentially
into a folders content.

5. Updated Customize Toolbar...options — ability to add more buttons to toolbar for functions not already included
i.e. update document tags.
6. Tags (both folder and document) can be listed in order of preference.

Features:
1. Email Importer Application. A comprehensive admin and user guide can be found here.
2. Secure Share Notifications. Notification of third-party interactions with secure DocMoto shares.
3. Hardening. Administrators can set up failed authentication limits and number of downloads permitted.

Integrations:

1. Google Mail (Please contact CHL Software for more details).

CHL Software
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http://www.docmoto.com/downloads/tech%20manuals/DocMoto%20-%20Email%20Importer%20Application.pdf

User Interface:

Existing Version 3 GUI:

eve [ contents
< ocahost B D) | & | & 8 B B¢l o ®| ¢
Back lee New Folder Check-In Check-Out Quick Look  Add Create Versions Views  Attach Favourites Shares  Refresh Search
EJ Name ~ Version Size  Checked In On Created By Comment
» {f Home - 1. OCR Inbox 26 July 2017 15:13 lee
U Trash [~ Admin 21 September 2016 14:05 administrator
(] Assembly 21 September 2016 16:52 administrator
- CHL Software 26 September 2016 15:35 administrator
=] Contracts 26 September 2016 15:55 administrator
- Legal 21 September 2016 14:06 administrator
(=] Monitored Folders 9 February 2017 16:54 lee
(=] News letters 2 August 2017 10:14 lee
- Projects 23 September 2016 14:26 administrator (c)
] Test Folder 30 May 2017 15:18 lee
(=] Training Folder 28 June 2017 15:36 lee
(a) ] Webinar 15 May 2017 11:34 lee
=] Workshops 25 September 2017 12:49 lee
v
P o
< (d) P
(e) (f) (9)
~  Details
& localhost > [ Contents
l 13 items ﬂ

(a) Tree View Pane - Primarily for folder navigation; containing three distinct areas, namely:

e Contents — shared workspace
e Home — users private area
e Trash — users trash bin

(b) Toolbar - Quick and easy access to DocMoto’s most common functions. Fully customisable.

(c) Search - DocMoto's search interface; supporting four keywords, namely:

e File Name

e Folder Name
e Content

e Tag

(d) Main View (pane) -Exposes the contents of any folder selected within the tree view. Displays five default columns

(can be customised), namely:
¢ Name
e Version Size
e Checked In On
e Created By
e Comment

(e) Detail Pane - Hidden slide draw displays the meta-data associated to the folder or file selected.
(f) Breadcrumb Trail — Displays the location of the item selected and is fully interactive i.e. if any item in the path is

selected, DocMoto will auto navigate to the area.
(g) Status Bar — Reflects the number of items selected or available.
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Version 4 GUI:

e0e £ Contents
locahost | | £ & & P ) 0 T Y A ® o o
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresh Search
Contents Search 1
S Name ~ Version Size Checked In On Creatdl By Comment
> #Tmp 20 February, 2018 11:21 AM lee
> 1. Cases 31 January, 2017 11:20 AM lee
U Trash @i (a) > W Admin 27 February, 2015 12:33 PM lee
@ Home » I Assembly 23 April, 2015 4:31PM lee
> CHL Software 27 February, 2015 11:13 AM lee
Favourites » 8 Contracts (d) 27 February, 2015 1:46 PM lee (e) (f)
B 2017.09.25 Do...Examples.docx » [ Hidden Folder 1 December, 2015 11:32 AM lee
Active Projects > B Legal 27 February, 2016 11:18 AM lee
. > Monitored Folders 27 February, 2015 11:30 AM lee
o) » B OCR Inbox 14 September, 2015 3:45 PM ee
Alpha - Project v Projects : ( ) 27 February, 2015 1:02 PM lee (g) :
n Application 1A.docx v Active g 27 February, 2015 1:09 PM lee
e v Alpha 27 February, 2015 1:16 PM lee
D Authorities 1A.docx » I Accounts 27 February, 2015 1:16 PM lee
h Banking Instructions 1B.docx > Client Area 27 February, 2015 1:16 PM lee
Davidson, David - Contracts 7 August, 2015 3:56 PM lee
> Correspondence 27 February, 2015 1:16 PM lee
Doc Assembly - Letter ¥ I Documents - Alpha 27 February, 2015 1:16 PM lee
B DocMoto Clou...ment - UK.pdf h Articles of Association.docx 1.8KB 25 January, 2018 1:58 PM lee Example tagging through browser
h Audit 1A.docx 26.9KB 27 February, 2015 4:04 PM lee
KDRGeR M Authorities 1A.docx 27.3K8 28 June, 2017 10:15 AM lee
Last Will And Testaments n Business Case Stage exp.docx 59.1K8 22 November, 2017 11:14 AM lee
Legal H (b) h Business Case Stage.docx 59 KB 29 October, 2015 3:23 PM lee
n Crider Law Example.docx 254 K8 13 June, 2016 6:53 PM lee
Renamed [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
Test Folder h DocMoto Implementation Check List.pdf 71.6 KB 11 July, 2016 11:46 AM . lee
Training 'ﬂ DocMoto Trial System Instructions.docx 542 KB 11 July, 2016 11:46 AM (I) lee
(C) @ DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Zeta B Index.docx 50.3K8 22 November, 2017 11:14 AM lee inserted some links
Bensnt Dooumarid > Media h 27 February, 2015 1:16 PM lee
. > Deita ( ) 27 February, 2015 1:17 PM lee
B Authorities 1A.docx » B Epsilon 27 February, 2016 4:30 PM lee
[ Application 1A.docx > B Eta 27 February, 2015 2:48 PM lee
B 2018.02.19 Sample Doc 1.docx » Kappa 28 September, 2015 10:26 AM lee
B DocMoto Cloud...ent - US.docx S - 2605 49 Root > il Contents:» AL
o
1 selected L2

(a) + (b) + (c) Side Panel — comprising three sections; DocMoto areas, Favourites & Recent Documents. The Side Panel
can be hidden or exposed.
(a) DocMoto areas — The three main areas within the DocMoto system:

e Contents — shared workspace

e Home - users private area

e Trash — users trash bin
(b) Favourites — Moved from the toolbar to the side panel to enable drag and drop in a similar fashion to the Finder
application. DocMoto has retained the ability to mark items as favourites via the menu items (File menu & Right mouse
click menu).
(c) Recent Documents — A list of all the recent documents (and folders) worked on.
(d) Tab (control) — A tab is a graphical control element that allows multiple documents (or folders, or panels) to be
contained within a single interface. This is especially useful in large repositories.
(e) Toolbar — Quick and easy access to DocMoto’s most common functions. Fully customisable.
(f) Search - DocMoto’s search interface; supporting four keywords, namely:

e File Name

e Folder Name
Content

e Tag
(g) Main View — The tree view and main view from version 3 have been integrated as one so documents and folders are
nested and available through one interface. This makes copying and moving data within one view easier.
(h) Info Pane - hidden by default, comprising:

e Breadcrumb Trail - Displays the location of the item selected and is fully interactive i.e. if any of the items in the

path is selected, DocMoto will auto navigate to the area
e Document Walker — An intelligent control enabling users to “walk” through documents within large folders when
the info panel is extended

e Details — Meta data extracted from documents or user defined

e Preview — Document or Folder preview
(i) Status Bar - Reflects the number of items selected or available

CHL Software
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Version 4 GUI - Side Panel:

The introduction of a side panel maximizes the viewable area within the main tree view. The side panel supports a slide in
and out control. To hide the side panel:

1. Place cursor over the line separator between the side panel and the main tree view. The cursor should change to
the resize cursor.

Fig. Resize Cursor:

+

2. Slide the side panel to the left until it's hidden. See Fig. Side Panel Hidden.

Fig. Side Panel Hidden:

[ ] [ ] E Contents
< beahost | | D) & | & D D¢ A ® @ D] @ &
Back lee New Folder Check-In Check-Out Add Create Attach Views Shares Update Tags Versions Quick Look Refresh Search
Contents Search +
Name ~ Version Size Checked In On Created By Comment

» I #Tmp 20 February, 2018 11:21 AM lee
> 1. Cases 31 January, 2017 11:20 AM lee
> Admin 27 February, 2015 12:33 PM lee
> Assembly 23 April, 2015 4:31 PM lee
> CHL Software 27 February, 2015 11:13 AM lee
» I Contracts 27 February, 2015 1:46 PM lee
» [ Demo Yesterday, 11:32 AM lee
» [ Hidden Folder 1 December, 2015 11:32 AM lee
» I Legal 27 February, 2015 11:18 AM lee
» [ Monitored Folders 27 February, 2015 11:30 AM lee
» [ OCR Inbox 14 September, 2015 3:45 PM lee
v Projects 27 February, 2015 1:02 PM lee
v Active 27 February, 2015 1:09 PM lee
v Alpha 27 February, 2015 1:16 PM lee
» [ Accounts 27 February, 2015 1:16 PM lee
» [ Client Area 27 February, 2015 1:16 PM lee
» [ Contracts 7 August, 2015 3:56 PM lee
» [ Correspondence 27 February, 2015 1:16 PM lee
¥ [ Documents - Alpha 27 February, 2015 1:16 PM lee

h Articles of Association.docx 11.8KB 25 January, 2018 1:58 PM lee Example tagging through browser
D Audit 1A.docx 26.9KB 27 February, 2015 4:04 PM lee
h Authorities 1A.docx 27.3KB 28 June, 2017 10:15 AM lee
h Business Case Stage exp.docx 59.1KB 22 November, 2017 11:14 AM lee
h Business Case Stage.docx 59 KB 29 October, 2015 3:23 PM lee
n DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
a DocMoto Implementation Check List.pdf 716 KB 11 July, 2016 11:46 AM lee
m DocMoto Trial System Instructions.docx 542 KB 11 July, 2016 11:46 AM lee
a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee

h Index.docx 50.3 KB 22 November, 2017 11:14 AM lee inserted some links
» I Media 27 February, 2015 1:16 PM lee
» I Deita 27 February, 2015 1:177 PM lee
» [ Epsilon 27 February, 2015 4:30 PM lee
» [ Eta 27 February, 2015 2:48 PM lee
» I Kappa 28 September, 2015 10:26 AM lee
0 « v L [ Root » [ Contents > i # Tmp
1 selected ﬂ

Note: If the side panel is hidden, it is only hidden within the active tab. If another tab is opened the side panel is shown
by default.

To expose the side panel, reverse the steps listed above.
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Fig. Side Panel - Collapsible Sections:

Keeping with the theme of maximizing viewable areas; the sections within the side panel (1) DocMoto (2) Favourites (3)

Recent Documents, all have options to show or hide. To hide a section within the side panel:

1. Place cursor to the right of the section header and a Hide or Show option will appear, depending on what state

the section is currently in. In this example, the Favourites section will be hidden.
2. Select the Hide option and the listings under the given section will be hidden. See Fig. Side Panel — Hide
Favourites listings.

Fig. Side Panel - Hide Favourites listings:

o0 e £ Contents
< localhost | ') & & S Ea) 7 bo) @ (¢ D L3 fs] Q
Back lee New Folder Check-In Check-Out Add Create Attach Views Shares Update Tags Versions Quick Look  Refresh Search
Contents Search +
Daceetey Name ~ VersionSize  Checked In On Created By Comment
_ » I #Tmp 20 February, 2018 11:21 AM lee
» [ 1. Cases 31 January, 2017 11:20 AM lee
U Trash » W Admin 27 February, 2015 12:33 PM lee
) Home » 8 Assembly 23 April, 2015 4:31PM lee
. » CHL Software 27 February, 2015 11113 AM lee
Favocsibes » I Contracts 27 February, 2015 1:46 PM lee
Recent Documents » B Demo Yesterday, 11:32 AM lee
B 2018.03.08 Sample Doc 5 » I Hidden Folder 1December, 2015 11:32 AM lee
» I Legal 27 February, 2015 11:18 AM lee
n 2018.03.08 Sample Doc 1.doc » I Monitored Folders 27 February, 2015 11:30 AM lee
Knowledge Base » I OCR Inbox 14 September, 2015 3:45 PM lee
> ¥ I Projects 27 February, 2015 1:02 PM lee
ot Y Ok (Tac.2012). o v I Active 27 February, 2015 1:09 PM lee
B DocMoto Imple...Check List.pd v I Alpha 27 February, 2015 1:16 PM lee
B Application 1A.docx » I Accounts 27 February, 2015 1:16 PM lee
» I Client Area 27 February, 2015 1:16 PM lee
[ 2018.02:19 Sample Doc 1.docy » I Contracts 7 August, 2015 3:56 PM lee
n DocMoto Clou...ment - US.dod » [ Correspondence 27 February, 2015 1:16 PM lee
W Temp ¥ 8 Documents - Alpha 27 February, 2015 1:16 PM lee
i h Articles of Association.docx 1N.8KB 25 January, 2018 1:58 PM lee Example tagging through browser
“ Docmoto Banner Folder B Audit 1A.docx 26.9K8 27 February, 2015 4:04 PM lee
h Authorities 1A.docx 27.3K8 28 June, 2017 10:15 AM lee
y b Business Case Stage exp.docx 59.1KB 22 November, 2017 11:14 AM lee
n Business Case Stage.docx 59 K8 29 October, 2015 3:23 PM lee
(a) [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
DocMoto Implementation Check List.pdf 716 KB 11 July, 2016 11:46 AM lee
b DocMoto Trial System Instructions.docx 542 KB 11 July, 2016 11:46 AM lee
DocumentMgt process.pdf 8.86 M8 5 July, 2017 12:07 PM lee
h Index.docx 50.3K8 22 November, 2017 11:14 AM lee inserted some links
» I8 Media 27 February, 2015 1:16 PM lee
» I Delta 27 February, 2015 1:17 PM lee
» I Epsilon 27 February, 2015 4:30 PM lee
» B Eta 27 February, 2015 2:48 PM lee
» [ Kappa 28 September, 2015 10:26 AM lee
“ v Ly B Root » [ Contents > Wl # Tmp
1 selected a

(a) Hide (& Show) — mouse over control to hide and show section listings.
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Tips & Tricks - How To:

This section covers how to interact with the new user interface.

Opening Tabs:

A tab is a graphical control element that allows multiple documents (or folders, panels) to be contained within a single
window.

This is especially useful in large document repositories.

Opening a generic tab:

Method 1:

This method opens a generic tab at the Contents level (non specific folder)

1. Select the + control in the top right-hand side of the user interface (beneath the search interface). As shown in
Fig. Tab Control marked as (a)

Fig. Tab Control

‘e0e@ & Contents
locahost | | £ & & [ D 0 U o) ) c
Back lee New Folder Check-In Check-Out Quick Look Add Create Versions Attach Views Shares Update Tags Refresh Search
Docmoto Name A Version Size Checked In On Created By Comment
_ > b #Tmp 20 February, 2018 11:21 AM lee
- 1. Cases 31 January, 2017 11:20 AM lee
U Trash » I Admin 27 February, 2015 12:33 PM lee (a) =
1 Home » I Assembly 23 April, 2015 4:31PM lee

2. A new tab will be opened displaying the contents of the “Contents” (shared area). As shown in Fig. New Tab
open - Contents marked as (a)

Fig. New Tab open - Contents

o0 e & Contents
localhost | ) & & > ) D D ] A ® ) )
Back lee New Folder Check-In Check-Out Quicklook Add  Create Versions Attach  Views  Shares Update Tags Refresh Search
Contents Search Contents 1
Docmoto Name ~ Version Size Checked In Or Created By Comment
> 1. Cases 31 January, 2017 11:20 AM lee
U Trash » I Admin 27 February, 2015 12:33 PM lee (a)
1 Home » I Assembly 23 April, 2015 4:31PM lee

Opening a folder within another tab:
Method 2:
This method opens a tab for a specific folder.

1. Select a folder to open in a new tab.
2. Select the Open in Tab option from either:
a. The File menu
b. Right mouse click menu (pop up or action menu)
c. The short cut emd + t. As shown in Fig. Open in Tab — Menu Option

CHL Software
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Fig. Open in Tab - Menu Option:

o0 e Contents
beahost Bl O | s &l ol Bldlole¢ellalel ]| c Q ses
Back lee New Folder Check-In Check-Out Quick Look  Add Create  Versions  Attach Views Shares  Update Tags Refresh Search
Contents Search =5
SRAY Name ~ Version Size Checked In On Created By Comment
_ > #Tmp 20 February, 2018 11:21 AM lee
» I 1. Cases (a) 31 January, 2017 11:20 AM lee
U Trash > B8 Admin 27 February, 2015 12:33 PM lee
1 Home » I Assembly 23 April, 2015 4:31 PM lee
» [ CHL Software 27 February, 2015 11:13 AM lee
Peboaties » I Contracts _ 27 February, 2016 1:46 PM lee (b)
@ 2017.09.25..mples.docx » I Hidden Folder Open in Tab 1December, 2015 11:32 AM lee
' Aardvark v..Idrick c.100 » B Legal Show in Finder... 27 February, 2015 11:18 AM lee
» [ Monitored Folders & E 27 February, 2015 11:30 AM lee
" Active Projects Copy link to Clipboard > ’
i > I OCR Inbox e crias 14 September, 2015‘3.45 PM lee
" Admin ¥ I Projects Compare > uary, 05 02 lee
I Alpha - Quick Look "Active” RS -
ph-n M » B8 Alpha 27 February, 2015 1:16 PM lee
[ Application 1A.docx » B Deita 27 February, 2015 1:17 PM lee
[ Authorities 1A.docx » B Epsilon 27 February, 2015 4:30 PM lee
- » BN Eta 27 February, 2015 2:48 PM lee
Banl In...ns 1B.d
o g --ns 96K » B Kappa Add Existing File(s) 28 September, 2015 10:26 AM lee
14 Davidson, David > Nu Create Document from Master 7 August, 2015 3:50 PM lee
¥ Doc Assembly - Letter » I Omega New Folder 5 February, 2016 11:23 AM lee Test
B DocMot ¢ - UK.pdf » [ Star Labs 3 October, 2016 5:06 PM lee
loto._.ent - UK.p » B Theta Edit Folder Properties 14 February, 2018 10:10 AM lee
9 Images » B Zeta N 16 January, 2018 3:10 PM lee
B Lot WIll A Testomerits » I Inactive Download Files 27 February, 2016 1:09 PM lee
» [ Signature Requirec & 9 April, 2015 3:48 PM lee
5 Legal » B Test Folder Check-Out to Edit (Lock) 4 March, 2015 11:41 AM lee
1 Renamed » I Training Undo Lock (Discard Changes) 2 July, 2015 413 PM lee
= TV Check-in to Confirm Changes 30 August, 2016 4:42 PM lee
o8t Foider Move To Trash
I Training Rename
8 Zeta

(a) Open in Tab — menu option (in this example, the right mouse click menu)

(b) Active (folder) — Active project folders to be opened in new tab

3. The Active (project folders) will be opened in a new tab. As shown in Fig. Active Projects in new tab.

Fig. Active Projects in new tab:

o0 e W Active
< localhost B ) & & 4 | ) D 172 g} » &
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares  Update Tags
Contents Search
B Name ~ Checked In On Created By
[E Contents 27 February, 2015 1:16 PM
» B Delta 27 February, 2015 1:17 PM lee
U Trash » B Epsilon 27 February, 2015 4:30 PM lee
18 Home > B Eta 27 February, 2015 2:48 PM lee
» [ Kappa 28 September, 2015 10:26 AM lee
Povoirties > N 7 August, 2015 3:50 PM lee
(W] 2017.09.25...mples.docx » 8 Omega 5 February, 2016 11:23 AM lee
" Aardvark v..Idrick 100 » [ Star Labs 3 October, 2016 5:06 PM lee
— » B Theta 14 February, 2018 10:10 AM lee
B 16 January, 2018 510 PM lee

' Admin
1 Alpha - Project
[ Application 1A.docx

(a) Active — Active projects folders opened in new tab.

~
=

Refrosh

Note: When tabs are opened they automatically open furthest to the right.
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Search

+1

Active

Comment

Test




Copying and Moving (folders or files):

Copying and moving folders and files in DocMoto has never been easier, whether copying in the same view or across
tabs.

In the Tree View:

1. Navigate to the item(s) to copy or move.

2. Drag the item(s) up or down the tree view (depending on where the item(s) need to be copied). Tip & Trick: If a
folder is not expanded, dragging the item(s) up or down the tree view and hovering over the folder will expand it,
exposing its contents.

3. Drop the item(s) to be copied or moved into the desired folder. Tip & Trick: Hover above a folder and it will
highlight to illustrate which folder is being updated. Hover underneath a folders hierarchy and a blue bar (with a
ring) will appear, illustrating where the item(s) will be copied or moved to. As shown in Fig. Copy/Move indicator

bar.

Fig. Copy/Move indicator bar:

‘e0e@ & Contents
bcahost B | D &l &)l @l DD D]e¢ 2l ®| 2| ¢
Back lee New Folder Check-In Check-Out Quick Look Aga Create  Versions  Attach Views Shares  Update Tags Refresh Search
Contents Search
Bocrnohs Name ~ Version Size Checked In On Created By Comment
C ts v Documents - Alpha 27 February, 2015 1:16 PM lee
h Articles of Association.docx 1.8KB 25 January, 2018 1:58 PM lee Example tagging through browser
T Trash B Audit 1a.docx 269K8 27 February, 2015 4:04 PM lee
ﬁ Home D Authorities 1A.docx 27.3K8 28 June, 2017 10:15 AM lee
n Business Case Stage exp.docx  59.1KB 22 November, 2017 11:14 AM lee
Favourttes [ Business Case Stage.docx 59 KB 29 October, 2015 3:23 PM lee
n 2017.09.25...mples.docx n Crider Law Example.docx 254 KB 13 June, 2016 6:53 PM lee
Aardvark v...ldrick ¢.100 n DocMoto Cloud...ment - US.docx 178 KB 5 July, 2017 12:07 PM lee
h DocMoto Imple...n Check List.pdf 71.6 KB 11 July, 2016 11:46 AM lee
Active Projects ) DocMoto Trial...Instructions.docx 542 KB 11 July, 2016 11:46 AM lee
Admin a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Alpha - Project h lnf!ex.docx 50.3KB 22 November, 2017 11:14 AM lee inserted some links
> Media 27 February, 2015 1:16 PM lee
B Application 1A.docx » B Delta 27 February, 2016 1:17 PM lee
B Authorities 1A.docx > Epsilon 27 February, 2015 4:30 PM lee
n Baniking bt..0s 18.docx > Eta 27 February, 2015 2:48 PM lee
» Kappa 28 September, 2015 10:26 AM lee
Davidson, David > Nu 7 August, 2015 3:50 PM lee
Doc Assembly - Letter > Omega (a) 5 February, 2016 11:23 AM lee Test
> Star Labs 3 October, 2016 5:06 PM lee
a DocMoto...ent - UK.pdf > Theta 14 February, 2018 10:10 AM lee
Images v Zeta 16 January, 2018 3:10 PM lee
Last Will A...Testaments a 2018.01.16 Docu...tMgt process.pdf 8.86 MB 16 January, 2018 3:50 PM lee
> Accounts 16 January, 2018 3:10 PM lee
Legal > Client Area 16 January, 2018 3:10 PM lee
Renamed > Contracts 16 January, 2018 3:10 PM lee
Test Folder > Correspondence 16 January, 2018 3:10 PM lee
v Documents - Zeta ™ 16 January, 2018 3:10 PM lee
Training "B 2018.01.16 Doc...gt process.pdf  8.86 MB - & 16 January, 2018 3:13 PM lee
Zeta h 2018.01.16 Sample Doc 1.docx ~ 30.6 KB 16 January, 2018 3:21 PM lee Inserted line of version text
Z; Benefits Of A D...t System.pages 137 KB 16 January, 2018 3:13 PM lee
Reosnk Docteeots 3 LexmarkAlOScant.tif 803 MB 16 January, 2018 3:13 PM lee
h DocMoto |...eck List.pdf > Media 16 January, 2018 3:10 PM lee
n Authorities 1A.docx » Inactive 27 February, 2015 1:09 PM lee
n Application 1A.docx e “- ~ v &5 Root > [ Contents > Projects » Active > Alpha » Documents - Alpha > n Index.docx
1 selected ﬂ

(a) Copy/Move indicator bar — to illustrate where the item(s) will be copied/moved. In this example, the document
Index.docx is being copied/moved from the Documents folder in the Alpha project to the Documents folder in the
Zeta.

4. Drop the item(s) to be copied or moved, a pop-up dialog prompts:
a. Copy
b. Move
c. Cancel

As shown in Fig. Copy, Move, Cancel — dialog.
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Fig. Copy,

Move, Cancel - dialog:

e0e & Contents
cahost | O & | & @ BB D¢ Al ®| © ]
Back lee New Folder Check-in Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresn
Contents
S, Name ~ Version Size Checked In On
Contents v Documents - Alpha 27 February, 2015 1:16 PM
h Articles of Association.docx 11.8KB 25 January, 2018 1:58 PM
O Trash B Audit 1a.docx 269K8 27 February, 2015 4:04 PM
1 Home [ Authorities 1A.docx 273K8 28 June, 2017 10:15 AM
n Business Case Stage exp.docx  59.1KB 22 November, 2017 11:14 AM
Fovairtes [ Business Case Stage.docx 59KB 29 October, 2015 3:23 PM
n 2017.09.25...mples.docx n Crider Law Example.docx 25.4KB 13 June, 2016 6:53 PM
8 Aardvark v..Idrick ¢.100 h DocMoto Cloud...ment - US.docx 178 KB 5 July, 2017 12:07 PM
. . B DocMoto Imple...n Check List.pdf 71.6 KB 11 July, 2016 11:46 AM
e A DocMoto Trial..instructions.docx 542 KB 11 July, 2016 11:46 AM
Admin DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM
= w  Index.docx 50.3 KB 22 November, 2017 11:14 AM
Alpha - Project
> Media 27 February, 2015 1:16 PM
B Application 1A.docx » I Deita 27 February, 2015 1:17 PM
B Authorities 1A.docx > Epsilon 27 February, 2015 4:30 PM
2 > Eta 27 February, 2015 2:48 PM
B Banking in..ns 18.docx » B Kappa 28 September, 2015 10:26 AM
Davidson, David > N 7 August, 2016 3:50 PM
Doc Assembly - Letter » Omega 5 February, 2016 11:23 AM
» [ Star Labs 3 October, 2016 5:06 PM
IR » B Theta 14 February, 2018 10:10 AM
Images v il Zeta 16 January, 2018 3:10 PM
Last Will A...Testaments a 2018.01.16 Docu...tMgt process.pdf 8.86 M8 16 January, 2018 3:50 PM
> Accounts 16 January, 2018 3:10 PM
Legal > Client Area 16 January, 2018 3:10 PM
Renamed > Contracts 16 January, 2018 3:10 PM
Test Folder > Correspondence 16 January, 2018 3:10 PM
v Documents - Zeta Move 16 January, 2018 3:10 PM
Training & 2018.01.16 Doc...gt process.pdf  8.86 MB 16 January, 2018 3:13 PM
Zeta n 2018.01.16 Sample Doc 1.docx  30.6 KB Cancel 16 January, 2018 3:21 PM
[! Benefits Of A D...t System.pages 137 KB 16 January, 2018 3:13 PM
Recent Docummts % LexmarkAlOScant.tif 803 MB 16 January, 2018 3:13 PM
a DocMoto ...eck List.pdf » B Media 16 January, 2018 3:10 PM
n Authorities 1A:docx » Bl Inactive 27 February, 2015 1:09 PM
n Application 1A.docx 0 - ALV [ Root > [ Contents > Projects > Active > Alpha > Documents - Alpha > m Index.docx
1 selected

Search

Search 1
Created By Comment
lee
lee Example tagging through browser
lee
lee
lee
lee
lee
lee
lee
lee
lee
lee inserted some links
lee
lee
lee
lee
lee
lee
lee Test
lee
lee
lee
lee
lee
lee
lee
lee
lee
lee
lee Inserted line of version text
lee
lee
lee
lee

5. Select the appropriate action from the pop-up dialog. In this example, copy.

The document is copied.

Between Tabs:

1. Select the destination folder where the item(s) need to be copied/moved to.
2. Select Open in Tab option from either:

a. The File menu.

b. Right mouse click menu (pop up or action menu)

¢. The short cut emd + t. As shown in Fig. Open in Tab — Menu Option

3. Select the source folder where the item(s) need to be copied/moved and subsequently select the item(s) to be

copied/moved.

4. Drag the item(s) from the source folder tab to the destination tab. A green plus icon will appear on the
destination tab. In this example, the document Audit.docx is dragged from the Documents — Alpha (project

folder) tab (source) to the Documents — Star Labs (project folder) tab (destination).

5. Drop the item(s) onto the destination tab (Documents — Star Labs) in this example. The Copy, Move, Cancel

dialog will appear. As shown in Fig. Copy, Move, Cancel - dialog (across tabs).

Fig. Copy, Move, Cancel - dialog (across tabs):

eoe Documents - Star Labs
bahost | D & & @ D D)D) ¢ B ® © &
Back lee New Folder Check-In Check-Out Quick Look ~ Add Craate . Versions  Attach  Views  Shares Update Tags Refresh Search
- Move |
Contents Documents - Star Labs Search or

DOteatiS Name Cancel Version Size Checked In On Checked In By

@ Contents n 2018.02.06 Authorities 1A.docx 27.3K8 6 February, 2018 2:44 PM lee

T Trash (a) (b) (c)

B Home

CHL Software
www.docmoto.com




(a) Source tab - item(s) to be copied or moved. In this example, Documents - Alpha (project folder).
(b) Copy, Move, Cancel dialog — operations available.
(c) Destination tab — area (folder) where the item(s) will be copied/moved.

6. Select the appropriate action. In this example — copy. The document is copied.

Copy & Move - Supplementary Section:

If a document has more than one version the copy option from the Copy, Move, Cancel dialog will have an additional
sub menu, offering:

e Current Revision — Only the current revision of the document
e All Revisions — All revisions of the document

Creating Favourites:

DocMoto users will already be familiar with the ability to create favourites (areas of significant interest) to ensure easy
navigation to specific areas within the repository. In the previous version of DocMoto favourites were listed as a drop-
down list, now the side panel supports drag & drop of items from anywhere in DocMoto — in keeping with the Finder
application. DocMoto still supports the ability to mark items as favourites through the File menu and the Right mouse
click menu.

To create a favourite using drag and drop:

1. Select the item to be marked as a favourite

2. Drag the item from the main tree view to the side panel into the section labelled Favourites

3. The Copy/Move indicator bar will appear as the item hovers over the Favourites section. Drop the item to make it
a favourite. As shown in Fig. Drag & Drop to Favourites

Fig. Drag & Drop to Favourites:

[ ] ® & Contents
locahost | | £ & & © ) D T ) A ® ) )
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresh Search
Contents Search t
S Name ~ Version Size Checked In On Created By Comment
E| Contents " #Tmp 20 February, 2018 11:21 AM lee
> 1. Cases 31 January, 2017 11:20 AM lee
T rash » I Admin 27 February, 2015 12:33 PM lee
’uﬁ Home > Assembly 23 April, 2015 4:31 PM lee
> CHL Software 27 February, 2015 11:13 AM lee
s » I Contracts 27 February, 2015 1:46 PM lee
Aardvark v...Idrick ¢.100 5 Hidden Folder 1 December, 2015 11:32 AM lee
Active Projects » 27 February, 2015 11:18 AM
e e S Monitored Folders 27 February, 2015 11:30 AM lee
Admin e » I OCR Inbox 14 September, 2015 3:45 PM lee
Alpha - Project > Projects 27 February, 2015 1:02 PM lee
n Application 1A.docx v Signature Required 9 April, 2015 3:48 PM lee
" > Test Folder 4 March, 2015 11:41 AM lee
B Authorities 1A.docx » I Training 2 July, 2015 4:13 PM lee
Doc Assembly - Letter > v 30 August, 2016 4:42 PM lee
B DocMoto...ent - UK.pdf (b)
Images
Last Will A...Testaments
Test Folder ! (a)
Training

Zeta
Recent Documents
B DocMoto I...eck List.pdf
B Authorities 1A.docx
B Application 1A.docx
B 2018.02.19...00c 1.docx
n DocMoto...nt - US.docx
B 2018.02.14 Letter.docx
Temp

28 Docmoto Banner Folder | ©

& Root > [ Contents > Legal

1 selected

- »]
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(a) Legal (folder) — dragged to favourites, copy/move indicator to illustrate
(b) Legal (folder) — within repository, situated under the Contents level

Note: Any item stored in DocMoto (file or folder) can be marked as a Favourite.

Amending a favourites label:

1. Select the favourite to amend
2. Single click on the favourite and an edit box will appear. See Fig. Amending Favourite.

3. Type the new label and select the return key to confirm (or click elsewhere in DocMoto). In this example, the label
has been changed from Legal to Legal Area. See Fig. Amended Favourite.

Fig. Amending Favourite:

o0 e Legal
< localhost B ) @ é [ a a .‘;, 0 @ @ e c

Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags  Refresh Search

Legal Search ~r

T Name ~ Version Size Checked In On Created By Comment

[ Contents » B Clients 27 February, 2015 11:27 AM lee
ﬁ _— > Knowledge Base 27 February, 2015 1:03 PM lee
ras|

1 Home
Favourites

Aardvark v...ldrick ¢.100
Active Projects
Admin
Alpha - Project

n Application 1A.docx

n Authorities 1A.docx
Doc Assembly - Letter

@ DocMoto...ent - UK.pdf
Images
Last Will A...Testaments

@)

Test Folder
Training

Zeta

(a) Editable Favourite Label

Fig. Amended Favourite:

eoe Legal

< bcahost B O | & | & @ B B D¢ Bl ® © ]

Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresh Search
Legal Search =+
Created By Comment

B Contents » 1 Clients 27 February, 2015 11:27 AM lee

> Knowledge Base 27 February, 2015 1:03 PM lee
U Trash

Docmoto Name ~ Version Size Checked In On

B Home
Favourites

Aardvark v...ldrick ¢.100
Active Projects
Admin
Alpha - Project

n Application 1A.docx

n Authorities 1A.docx
Doc Assembly - Letter

B DocMoto...ent - UK.pdf
Images
Last Will A...Testaments

@)

Test Folder
Training

Zeta

(a) Favourite Label Amended
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Removing a favourite:

1. Select the favourite to remove
2. Select the delete key

The favourite will be removed from the favourites list.

Recent Documents:

An intelligent list of all the recent documents (potentially folders) worked on. Items within the Recent Documents section

are listed — most recent first, least recent last. See Fig. Recent Documents.

Fig. Recent Documents:

e0e [ Contents
<> localhost B ) & & [ | a V] ¥o) @ Pe) q
Back lee New Folder Check-In Check-Out Quick Look Add Create Attach Views Shares  Update Tags Search
Contents Test Folder
= Name A~ Version Size Checked In On Created By Comment
Contants » #Tmp 20 February, 2018 11:21 AM lee
» 1. Cases 31 January, 2017 11:20 AM lee
U Trash (b) » B Admin 27 February, 2015 12:33 PM lee
ﬁ Home » I Assembly 23 April, 2015 4:31 PM lee
» CHL Software 27 February, 2015 11:13 AM lee
e >l Contracts 27 February, 2015 1:46 PM lee
Recent Documents > Hidden Folder 1December, 2015 11:32 AM lee
I B Knowledge Base l — Legal 27 February, 2015 11:18 AM lee
N - » Monitored Folders 27 February, 2015 11:30 AM lee
B Wonderfish v Ci..8 (Tex.2012).pdf » I OCR Inbox 14 September, 2015 3:45 PM lee
Q DocMoto Imple...on Check List.pdf » Projects 27 February, 2015 1:02 PM lee
i Si Requil April, 2015 3:48 PM I
n Athonties 1A dac » Signature Required 9 April, 2015 3:48 P! ee
» [ Test Folder 4 March, 2015 11:41 AM lee
B Application 1A.docx » B Training 2 July, 2015 413 PM lee
n 2018.02.19 Sample Doc 1.docx »im v 30 August, 2016 4:42 PM lee
B DocMoto Cloud...ement - US.docx = 4 (a)
B 2018.02.14 Letter.docx
Temp
- —
I ¥ Docmoto Banner Folder l »
*» (c)

(a) Recent Documents — full listing of all the recent documents (potentially folders) worked on
(b) Most Recent — the most recent item worked on
(c) Least Recent — the least recent item worked on
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Info Pane:

Slide controlled split pane view illustrating:

e Details — audit information about the item selected

e Preview —document or folder preview

e Document Walker - intelligent controls to “walk” through documents within large folders when the Info Pane is
fully extended (giving the end user a restricted view of the folders contents)

e Breadcrumb Trail - intelligent control illustrating location in DocMoto with useful built-in navigational controls

Fig. Info Pane:

ece & Contents
< > [locahost B &) & & b 8 D D g | @ <] <
Back lee New Folder Check-In Check-Out Quick Look Aga Create  Versions  Attach Views Shares Update Tags Refresh Search
Contents Test Folder t
S Name ~ Version Size Checked In On Created By Comment
= R ———— ouUno b - oo (e)
Contents [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
ﬁ Trash h DocMoto Implementation Check List.pdf 71.6 KB 11 July, 2016 11:46 AM lee
ﬁ H w_DocMoto Trial System Instructions.docx 11 July, 2016 11:46 AM
lome
a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Favourites n Index.docx 50.3K8B (d) 22 November, 2017 11:14 AM lee inserted some links
3 Media 27 February, 2015 1:16 PM lee
RECat Demuments » I Defta 27 February, 2016 1:17 PM lee
Knowledge Base ~ Cnrilan
a Wonderfish v Ci...8 (Tex.2012).pdf 0 « ~ v ’9 Root > [ Contents > Projects » Active > Alpha > Documents - Alpha » 1% DocMoto Trial System Ins(rucuons.docx‘
a DocMoto Imple...on Check List.pdf 0 [4 Open to Edit
. Details
B Authorities 1A.docx —
g DocMoto Trial System Instructions.docx
n Application 1A.docx ¥
Version 1
B 2018.02.19 Sample Doc 1.docx
¥ KeyInfo
n DocMoto Cloud...ement - US.docx
B 2018.02.14 Letterdocx Name DocMoto Trial System Instructions.docx
Document ID 6675B9C3-8C22-4A79-8871-0CEDS0880A2A
Temp i
Version Number 1
.
Docmoto Banner Folder Initial Check In  Mon Jul 11 11:46:47 BST 2016
Created By lee
Checked InOn  Mon Jul 11 11:46:48 BST 2016
p—
CheckedInBy  lee (a)
(c) —
¥ Full Details
Name DocMoto Trial System Instructions.docx
Document 1D 6675B9C3-BC22-4A79-8871-0CED50BB0A2A
File Last Modified Tue Jan 20 10:16:17 GMT 2015
Vorsion Number 1
Checked Out Date Wed Jun 28 09:58:02 BST 2017
Comment
File Size 542 kB
=
File Type DOCX
1 selected

(a) Details

(b) Preview

(c) Document Walker
(d) Breadcrumb Trail
(e) Active Document
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Info Pane - Details:

ece & Contents
< >llocahost B © |l & & © BB D] ¢ B ® [ 2]
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresh Search
Contents Test Folder 1
S Name ~ Version Size Checked In On Created By Comment
. Ll DUSIIESS Labe SLdYe.uuLx 99 o £3 ULwue, ZU1D 3.3 FM 1ee
Contents [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
U Trash a DocMoto Implementation Check List.pdf 71.6 KB 11 July, 2016 11:46 AM lee
m bt w DocMoto Trial System Instructions.docx 542 KB 11 July, 2016 11:46 AM lee
a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Favourites b Index.docx 50.3K8B 22 November, 2017 11:14 AM lee inserted some links
> Media 27 February, 2015 1:16 PM lee
RECAts Desumeots > I Deita 27 February, 2016 1:17 PM lee
Knowledge Base ~ Eneilan 77 Eahriani NS A4:30 DA Inn
a Wonderfish v Ci...8 (Tex.2012).pdf 0 -« A v I Root > [{ Contents > Projects » Active > Alpha > Documents - Alpha > m DocMoto Trial System Instructions.docx

E DocMoto Imple...on Check List.pdf
b Authorities 1A.docx

[4 Open to Edit

s (@) S—

DocMoto Trial System Instructions.docx (——————— (b)
Version 1 () — ()

n Application 1A.docx
B 2018.02.19 Sample Doc 1.docx

¥ KeyInfo
[ DocMoto Cloud...ement - US.docx
B 2018.02.14 Letterdocx Name DocMoto Trial System Instructions.docx
Document ID 667589C3-8C22-4A79-8871-0CEDS0880A2A

Temp
Version Number 1 d
Docmoto Banner Folder Initial Check In  Mon Jul 11 11:46:47 BST 2016 ( )
Created By lee

Checked In On Mon Jul 11 11:46:48 BST 2016

Checked In By  lee
¥ Full Details

Name DocMoto Trial System Instructions.docx

Document 1D

File Last Modif

Vorsion Numbor

6675B9C3-BC22-4A79-8871-0CEDS0BB0A2A
ied  Tue Jan 20 10:16:17 GMT 2015
1

Checked Out Date Wed Jun 28 09:68:02 BST 2017

Comment
File Size

542 kB
DoeCx

= (e)

1 selected

(a) Document Operations:

e Open to View — Open the document in its native format in Read Only mode

e Open to Edit - Open the document in its native format in Read & Write mode
(b) Document Name — Name of the document selected
(c) Current Version — The current version of the document selected. In this example, version 1
(d) Key Info — Key information about the item in question, namely:

e Name - Name of the document selected

e Document ID - Every document in DocMoto is assigned a unique document id

¢ Initial Check In - When was the document checked-in for the first time

e Created By — Who created the document

e Checked In On — When was the last revision checked-in

e Checked In By — Who was the last user to revision the document
(e) Full Details — All other meta-data associated to the document. Whether its meta-data extracted from the document
(created by the host application) or DocMoto specific meta-data
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Info Pane - Preview:

ece & Contents
< > | [locahost B £ & & L3 B 0 D 1 ol @ (%4 < Q
Back lee New Folder Check-in Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresn Search
Contents Test Folder 1
S Name ~ Version Size Checked In On Created By Comment
Ll DUSIIESS Labe SLdYe.uuLx vono £3 ULwue, ZU1D 3.3 FM 1ee
Contents [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
ﬂ Trash a DocMoto Implementation Check List.pdf 71.6 KB 11 July, 2016 11:46 AM lee
ﬁ} bt w DocMoto Trial System Instructions.docx 542 KB lee
B DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Favourites B index.docx 50.3K8B 22 November, 2017 11:14 AM lee inserted some links
- > Media 27 February, 2015 1:16 PM lee
SO Dotuments » I Deita 27 February, 2015 1:17 PM lee
Knowledge Base ~ Cneilan 77 Cahriian IR A:20 DA lon,
.
a Wonderfish v Ci...8 (Tex.2012).pdf 0 “ A v I Root > [{ Contents > Projects » Active > Alpha > Documents - Alpha » Iﬂ DacMoto Trial System Instructions.docx
DocMoto Imple...on Check List.pdf P 1 [4 Open to Edit
e Details
n Authorities 1A.docx
S DocMoto Trial System Instructions.docx
n Application 1A.docx
Version 1
B 2018.02.19 Sample Doc 1.docx
¥ Keynfo
n DocMoto Cloud...ement - US.docx
B 2018.02.14 Letterdocx Name DocMoto Trial System Instructions.docx
Document D 667589C3-8C22-4A79-8871-0CED50880A2A P
Temp (a)
Version Number 1
.
Docmoto Banner Folder Initial Check I Mon Jul 11 11:46:47 BST 2016 ik s W i
Created By lee I
Checked In On  Mon Jul 11 11:46:48 BST 2016
Checked InBy  lee
¥ Full Details
Name DocMoto Trial System Instructions.docx
Document 1D 6675B9C3-BC22-4A79-8871-0CEDS0BB0AZA
File Last Modified Tue Jan 20 10:16:17 GMT 2015
Version Number 1
Checked Out Date Wed Jun 28 09:68:02 BST 2017
File Size 542kB
File Type DOCX
1 selected
. . R B R . .pe .
(a) Preview — Document preview. If a folder is selected, the folders’ details are listed — specifically:
e Name
o Size
e Last Modified

(b) Navigational Aid - Forward and backward navigation aid for multipage documents

Info Pane - Document Walker:

e0e E Contents
< >locahost B O |l & & © BB D] @2 B ® © 2] Q
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresh Search
Contents Test Folder 1
S Name ~ Version Size Checked In On Created By Comment
Ll DUSIIESS Labe SLEYe.uuLx v o £3 ULwue, ZU1D 3.3 FM =
Contents [ DocMoto Cloud Licence Agreement - US.docx 178 KB 5 July, 2017 12:07 PM lee
ﬂ Trash DocMoto Implementation Check List.pdf 71.6 KB 1 July, 2016 11:46 AM lee
fﬂ? b w DocMoto Trial System Instructions.docx 542 KB 1 July, 2016 11:46 AM lee
a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Favourites h Index.docx 50.3K8B 22 November, 2017 11:14 AM lee inserted some links
. Media 27 February, 2015 1:16 PM lee
Je0as Dostuments » I Deita 27 February, 2015 1:17 PM lee
Knowledge Base ~ Eneilan 77 Cahrians MK A4:30 DA Inn
a Wonderfish v Ci...8 (Tex.2012).pdf 0 “ A Contents » Projects » Active > Alpha > Documents - Alpha > m DacMoto Trial System Instructions.docx
DocMoto Imple...on Check List.pdf [4 Open to Edit
" Details
B Authorities 1A.docx
e DocMoto Trial System Instructions.docx
n Application 1A.docx
Version 1 (a)
[ 2018.02.19 Sample Doc 1.docx
¥ Keylnfo
[ DocMoto Cloud...ement - US.docx
B 2018.02.14 Letterdocx Name DocMoto Trial System Instructions.docx
DocumentID  6675B9C3-8C22-4A79-8871-0CEDS0880A2A
Temp

Version Number 1

Docmoto Banner Folder Initial Check In

Mon Jul 11 11:46:47 BST 2016
ee

Mon Jul 11 11:46:48 BST 2016

Created By
Checked In On

Checked In By lee

¥ Full Details

Name DocMoto Trial System Instructions.docx

Document 1D 6675B9C3-BC22-4A79-8871-0CEDS0BB0A2A

File Last Modified
Vorsion Numbor
Checked Out Date
Comment

File Size

File Type

Tue Jan 20 10:16:17 GMT 2015
1
Wed Jun 28 09:58:02 BST 2017

542 kB
DOCX

1 selected
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(a) Document Walker - intelligent controls to "walk” through documents within large folders when the Info Pane is fully
extended (giving the end user a restricted view of the folders contents). The controls are as follows:

e Up — Navigate up through the document list

e Down - Navigate down through the document list

e In—Navigate into a folder

e Out - Navigate out of a folder

Info Pane - Breadcrumb trail:

o0 e & Contents
< >locahost B O & & @ BB D)2 A ® @ < Q
Back lee New Folder Check-in Check-Out Quick Look Add Create  Versions  Attach Views Shares Update Tags Refresn Search
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a DocumentMgt process.pdf 8.86 MB 5 July, 2017 12:07 PM lee
Favourites h Index.docx 50.3K8 (a) 22 November, 2017 11:14 AM lee inserted some links
- Media 27 February, 2015 1:16 PM lee
RS8R Dosuments > I Deita l 27 February, 2015 1:17 PM lee
Knowledge Base ~ Cneilan
a Wonderfish v Ci...8 (Tex.2012).pdf 0 “ A v ’Q Root > [ Contents » Projects » Active > Alpha > Documents - Alpha > m DocMoto Trial System Instmcnons.dccx‘
B DocMoto Imple...on Check List.pdf & [4 Open to Edit

. Details
n Authorities 1A.docx

DocMoto Trial System Instructions.docx

Version 1

n Application 1A.docx
B 2018.02.19 Sample Doc 1.docx

[ DocMoto Cloud...ement - US.docx
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B 2018.02.14 Letter.docx © o et W
Document ID  6675B9C3-8C22-4A79-8871-0CEDS0880A2A

¥ Keyinfo

Temp

Version Number 1
i Docmoto Banner Folder Initial Check In  Mon Jul 11 11:46:47 BST 2016
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Checked Out Date Wed Jun 28 09:58:02 BST 2017
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e (a) Breadcrumb Trail - intelligent control illustrating location in DocMoto with useful built-in navigational
controls. This control is especially useful with the info pane fully extended and a limited view.

Toolbar:

DocMoto has an updated toolbar in terms of:
e Favourites has been removed (and put on the side panel)
e Update Tags has been added
e Fully customizable - add or remove buttons and place buttons in order of preference

Fig. Toolbar

ece [ Contents
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CHL Software
www.docmoto.com



To customize the toolbar:

1. Right mouse click on the toolbar and a pop-up menu will appear giving the following options:
a. lcon and Text
b. Icon Only
¢. Customize Toolbar...

2. Select the Customize Toolbar option. See Fig. Customize Toolbar.

Fig. Customize Toolbar:

o0 e [ Contents  Icon and Text
icon Onl:
localhost | ) & & £ | L) ) e 2 @ [ < 2 Q
Back joe New Folder Chock-In Check-Out QuickLook Add  Create Versions Attach  Views  Shares Update Tags Refresn Customize Toolbar... Search

3. To customize the toolbar, open the dialog the following options will be shown:
a. Drag toolbar items in order of preference. This must be done on the toolbar itself and not the customize
toolbar dialog.
Remove toolbar items. This must be done on the toolbar itself by dragging items off the toolbar.
c. Add toolbar items. This must be done on the customize toolbar dialog by dragging items off the first
section onto the toolbar.

Fig. Customize Toolbar Dialog:

L] & Contents
ocahost B D & | & A DD ¢ b ® o =
Back lee New Folder Check-In Check-Out Quick Look Add Create  Versions  Attach Views Shares  Update Tags Refresh Search
<k
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Contents
it | O & & © D B D ¢ B = ® =& =
Trash
g Back Choose Server New Folder Check-In Check-Out Quick Look  Add Create Versions  Attach Refresh Refresh Space Flexible Space
B Home
Favourites ... or drag the default set into the toolbar.
r ...Idri
Aarcteade vAdricg bahost | O & & @ B B D ¢ B ® © 2 »
Active Projects
Back lee New Folder Check-In Check-Out Quick Look  Add Create Versions Attach  Views  Shares Update Tags Refresn
Admin
Alpha - Project
Show | Icon and Text E Use small size ﬁ

n Application 1A.doc

Fig. Customized Toolbar illustrates a customized toolbar

Fig. Customized Toolbar:

[ ] [ ] E Contents
ocahost | | &) & & D 8 ¢ Al ® ) (o) @ c_l—O (a)
Back lee New Folder Check-In Check-Out Add Create Attach Views Shares Update Tags| Versions Quick Look) Refresh Search

(a) Versions & Quick Look buttons moved from original positions. Refer to Fig Toolbar.

Update Tags:

Update Tags function now available through the toolbar.

CHL Software
www.docmoto.com



Tag Ordering:
In previous versions of DocMoto tags whether folder or document based are listed alphabetically. DocMoto V3.8 included
document assembly or automation and subsequently tag ordering became more important as users need to order tags in

order of preference and not alphabetically.

This functionality is now available either manually (i.e. setting tags against an existing folder) or can be set within Folder
Templates so the creation and assignment is automatic.

Setting Tag Order - against an existing folder:

—_

Select the folder to adjust the properties
Select the “Edit Folder Properties” from either:
a. The File menu
b. The right mouse click menu (pop-up or action menu)
c. The short-cut cmd + shift + e
3. Adialog is presented to add/remove/adjust:
a. Folder Tags
b. Folder Columns
¢. Document Tag
In this example we will adjust the document tags on the folder Contracts. Select the Document Tags tab.
The Contracts folder has 10 document tags as shown in Fig. Contracts Folder — Document Tags.

N

v

Fig. Contracts Folder - Document Tags:
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-
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> . L -
Aardvark v...drick ¢.100 > Cal Calendar
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[ Application 1A.docx vi First Review All Day
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Legal Area - =
Test Folder (d) d—
Training Note: Tags can be created by ini s using Tag M:
Zeta
Recent Documents Cancel (TSN *
L
= h Index.docx 50.3K8 22 November, 2017 11:14 AM lee inserted some links
B Wonderfis...x.2012).pdf > Media 27 February, 2015 1:16 PM lee
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n . > Epsilon 27 February, 2015 4:30 PM lee
Authorities 1A.docx > I Eta 27 February, 2015 2:48 PM lee
n Application 1A.docx > Kappa 28 September, 2015 10:26 AM lee
> Nu 7 August, 2015 3:50 PM lee

B 2018.02.19...D0c 1.docx

B DocMoto...nt - US.docx ©® <« ~ v o BRoot> [ Contents > i Contracts

- »)

1selected

(a) Document Tags — Tab to enable users to add/remove/adjust document tags

(b) Registered Tags — Tags registered

(c) Mandatory or Optional? — Set Required for mandatory adherence to rule or non-checked for optional
(d) Add or Remove — Buttons to add or remove tags

6. Select and drag tags in order of preference. See Fig. Contracts Folder — Reordering Tags.

CHL Software
www.docmoto.com



Fig. Contract Folder - Reordering Tags:

° & Contents
beahost B O & & DDAl ®)] @) D 2
Back ee New Folder Check-In Check-Out  Add Create  Attach  Views  Shares Update Tags Versions Quick Look Refresh Search
+
e Name Folder Name:
O Comens Foir Tage _ Focer o
U Trash > : : Set any tags that you wish users to complete when adding files to this folder. Tags will be optional unless you mark them as required
1) Home > (Req'd).
Favourites : : : Included Tags Required

Aardvark v..Idrick ¢.100 ™ iCal Calendar . .\ poview Title
Active Projects > . First Review Date . -
Admin : : ; First Review Alarm(s)
Alpha - Project v First Review Attendee(s)

B Application 1A.docx vi First Review All Day (a)

B Authorities 1A.docx 1 First Review End Time
Doc Assembly - Letter First Review Start Time

B DocMoto...ent - UK.pdf First Review Notes
Images First Review Title
Last Will A...Testaments First Review Type through browser
Legal Area
Test Folder + |-
Training Note: Tags can be created by ini using Tag
Zeta

Recent Documents Cancel m ?

(a) The (document) tag First Review Title is dragged from the second to last item to the second item. A useful blue drag
indicator is placed on the dialog to indicate the position of the drop.

7. Once tag reordering is complete, select the OK button to confirm

Any user importing or creating a document within the Contracts folder will now be presented with a new document tag
order. See Fig. Contracts Folder — Reordered Tags.

Fig. Contracts Folder — Reordered Tags:

L] I Contracts
localhost B ) & & i ) V7 2 @ (¢ D ]
Back ee New Folder Check-In Check-Out  Add Create  Attach  Views  Shares Update Tags Versions Quick Look Refresh Search
€t Checking in the following... t
Docmoto o
@ contents Service Contracts.docx
U Trash Complete any tags as necessary
1 Home
Tag Value
R Comment n - )
Aardvark v...Idrick ¢.100
Active Projects .
oo iCal Calendar Select a calendar from the list B
imin
Alpha - Projec First Review Title
Ipha - t
n Anoioation 1A.0 First Review Attendee(s)
pplication 1A.docx
. First Review Alarm(s) Select a notification B
n Authorities 1A.docx Fist Review b, - (a) (b) - .
DaAeanbly Hlatter irst Review Date (c)
DocMoto...ent - UK.pdf First Review All Day True
[ First Review Start Time
Last Will A...Testaments First Review End Time
Legal Area First Review Notes
Test Folder First Review Type a Event B
= l
Training
BN Zeta
Recent Documents + |-
I Knowledge Base
B Wonderfis...x.2012).pdf cancel | (N -
B DocMoto I...eck List.odf

(a) Tag — name of tag
(b) Value - values assigned to tag

(c) Optional — The Vv icon signifies no values need to be set (setting tags is optional). Hence the OK button is enabled. If
the tags were mandatory, the icon is set to ! and the OK button is disabled until values have been set.
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Setting Tag Order - Template Manager:
Note: The Template Manager is only available to administrators.

1. Select the Template Manager from the Admin menu

2. Navigate to the folder template requiring adjustment. In this example, the folder template - Demo

3. Select the appropriate tags tab (Folder or Requested). In this example, the Folder Tags tab. See Fig. Demo Folder
Template — Folder Tags

Fig. Demo Folder Template - Folder Tags:

L ] # Tmp

localhost | <] £ & & 0 5| 7 %)
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4 5 Audio Folder Tag - . Value
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@ Documents
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Fav

{firstname} Not Set

=) Email Folder = (b) (C) -

» &) Example Criminal Case {fullname}
» 55! Example Real Estate Case {title} NoEBat
=, Image Folder
<1 Movie Folder

i

i

1 Not Set
]

: » 5l New Client {salutation} _J b Dear
|

H

1

1

4

1

1

il

{town} Not Set

» 51 New Corporate Matter
» &1 New Finance Client
» 51 New Guardian ad Litem Matter
» 5l New IP Matter
» & New Litigation Matter
» £l New Media Project
» i New Mediation Matter
» 51 New Project
) Permissions Template
» 5. Personnel
» 51 Tag Order Template (d)

|
! Add Folder Add File ags and Values that apply to the new folder
L

Apply this template retrospectively on save. See help for details. Close ?

0 selected (]

(a) Folder Tags (tab) — Select to add/remove/adjust folder tags associated to the folder selected within the folder
template. In this example - the parent folder

(b) Registered Tags — Tags registered

(c) Tag Values — Default values set against folder tags. When the folder template Demo is run, the folder tags and default
values will be automatically set

(d) Add or Remove - Buttons to add or remove tags

4. Select and drag tags in order of preference. See Fig. Demo Folder Template — Reordering Tags.
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Fig. Demo Folder Template - Reordering Tags:

[ ] # Tmp

localhost | ) & & ) 3 ¢ a

Shares Update Tags Versions Quick Look Refresh Search

Add Template m Permissions  View Columns  Requested Tags

¥ Templates
» 5 Architectural
b Audio Folder Tag = L Value
» - Demo {addresslinel} i) Not Set
:j Emall F°lde,' . {addressline2} Not Set
» 5! Example Criminal Case (a)
» 55} Example Real Estate Case {company}
=i Image Folder {firstname} Not Set
} Movie Folder
) New Client
) New Corporate Matter {title) Not Set
) New Finance Client
) New Guardian ad Litem Matter
&1 New IP Matter {salutation} Dear
) New Litigation Matter
&1 New Media Project
) New Mediation Matter
» 51 New Project
=, Permissions Template
» 5% Personnel
» ) Tag Order Template

Not Set

Not Set
{fullname} Not Set

>
>
>
> {town} Not Set
>
>
>
>

Add Folder Add File + Tags and Values that apply to the new folder

Apply this template retrospectively on save. See help for details. Close

(a) The (folder) tag {firstname} is dragged from the fourth item listed to the first item. A useful blue drag indicator is
placed on the dialog to indicate the position of the drop.

5. Once tag reordering is complete, select the Close button to confirm
6. Select “Yes” to save the changes.

The folder tags associated to the parent folder will be created in the order defined by the folder template — Demo. This is
especially useful when dealing with document assembly as details can be completed in a logical order (i.e. not

alphabetized).

Fig. Folder Tags Reordered below illustrates a folder structure created via the folder template — Demo.

The user has selected the “Edit Folder Properties” from either:
e The File menu.
e The right mouse click menu (pop-up or action menu).
e The short cut — cmd + shift + e

The folder tags assigned to the parent folder (Folder Tag Ordering) have been reordered in accordance with the changes
made. Of course, the tag ordering will be preserved so that each time the folder template is used the tag ordering will be
correct.
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Fig. Folder Tags Reordered:
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(a) Folder Tags - listed in order defined by the folder template - Demo

CHL Software
www.docmoto.com



Secure Share Notifications:

DocMoto supports secure sharing with third parties. Third parties are not registered DocMoto users therefore can be
defined as anonymous, bar the email address used to send the share details. We have had requests to support
notifications when secure shares are:

1. Accessed
2. Documents uploaded
3. Documents updated

DocMoto V4 includes a server side setting that enables administrators to set up secure share notifications. These settings
include:

1. Scheduling:
a. How frequent does the service run? For example:

i. Every day including weekends

ii. Every day excluding weekends

iii. Work days only (Monday to Friday)

iv. Between certain hours (i.e. 09:00 — 17:00) on some days (week days) and other hours for

weekends
v. How frequent the service checks the shares — every minute, 15, 30, etc.

There is no user interface for this functionality administrators must be familiar with:
1. The Terminal application

2. Crontab - a file which contains the schedule of cron entries to be run and at specified times. File location varies
by operating systems

Perquisites:

1. The Email Server Configuration must have valid SMTP settings
2. Any user creating a share must have a valid email address registered against their user profile

Caveats:
Users receiving share notifications will be informed of:

Date — when the action occurred

Share — name of the share

Action — what took place

Location — where the action took place

Recipient — the email address of the recipient (of the share details)

AW =

DocMoto can only assume the recipient was the person who logged into the share and subsequently carried out
transactions. If multiple recipients were included on a share only the first email address used would be listed in the
notification.

Please contact CHL Software if you would like to know more.
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Hardening:
Admin controls to inhibit user download levels and number of unsuccessful logins.

DocMoto V4 includes a server side setting that enables administrators to set up user download levels and number of
unsuccessful logins. These settings include:

1. Number of failed logins — when set users will be locked out of the system if their login fails more than x number
of times (where x = number).
2. Set download limits — when set users will not be able to download more than the allocated limit. Administrators
can set the following:
a. Defaults - per day, per week, per month
b. Keys - these enable administrators to create keys for different download configurations, such as:
i. Normal — a download profile for standard users
ii. Full —a download profile for heavy (or frequent) users

There is no user interface for this functionality administrators must be familiar with:
1. The Terminal application.

The DocMoto login dialog has been updated so users can view which of the download options has been applied to their
profile.

Please contact CHL Software if you would like to know more.
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